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Although the State of Ohio, Department of Administrative Services Office of Information 

Technology strives for accuracy in its publications, any publication may contain inaccuracies or 

typographical errors. Changes, corrections and improvements may be made periodically to 

these publications and will be incorporated in new versions. Please refer to the Office 365 

website for the latest version of all documentation. http://office365.ohio.gov/  
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AGENCY ENGAGEMENT  

OFFICE 365 REFERENCE GUIDE 
OVERVIEW 
This reference guide, which includes an Agency checklist, will 

assist you in performing the necessary tasks associated with 

the Office 365 Agency email migration.   

Reference Guide Information 
The reference guide provides information and instructional 

materials for your Agency’s technical staff so that they may 

assist users and ready the Agency’s environment for an easy 

transition to Office 365. 

  

OFFICE 

365 

Office 365 is a 

Microsoft hosted 

messaging solution, 

and delivers Outlook 

as a cloud-based 

service, which means 

that your email 

services and data will 

be located in the 

cloud.  By utilizing this 

service, it removes the 

operational burden for 

an on-premises hosted 

email service. 
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OFFICE 365 INITIAL MIGRATION REPORT 

PRE MIGRATION CHECKLIST 

Agency Tasks 
 Verify that all desktop systems are up-to-date with patching 

 Verify Registry Fix has been Implemented 

 Remediate Users with Missing State of Ohio User IDs  

 Confirm Shared Mailbox Sizes 

 Identify and Supply White Glove List 

 Identify and Supply Do Not Migrate List 

 Identify Mailboxes under a legal hold 

 Identify and Supply Necessary Licensing Types for Mailboxes 

 Confirm List of Mobile Devices 

 Email Application Assessment  

 Ensure Staff has Completed Forefront Identity Management Training 

OIT Tasks 
 Establish Open Line of Communication with Agency Contact 

 Remediate Resource Accounts with Missing State of Ohio User IDs  

 Remediate Improperly Formatted UPN Values 

 Consolidate and Match ID/EM Environmental Counterparts 
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OFFICE 365 INITIAL MIGRATION REPORT 

PILOT ACTIVITIES 

Agency Tasks 
 Supply Pilot List 

 Execute UAT Scripts 

OIT Tasks 
 Convert Shared Mailboxes 

 Update Mail Enabled User Objects  

 Freeze Changes to User Objects 

 Run Preflight Analysis 

 Resolve Any Preflight Issues 

 Migrate Mailboxes 

 Apply Licensing 

 Establish Legal Holds 

OIT and Agency Tasks (Joint Responsibility) 
 Pilot Sign-off 

• OIT Sign-off 

• Agency Sign-off 

OIT and Agency Tasks (Joint Responsibility) 
 Go – No/Go Decision 
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OFFICE 365 INITIAL MIGRATION REPORT 

VELOCITY ACTIVITIES 

Agency Tasks 
 Supply Velocity List 

 Verify Auto Discover Capabilities are Functionality 

OIT Tasks 
 Convert Shared Mailboxes 

 Update Mail Enabled User Objects  

 Freeze Changes to User Objects 

 Run Preflight Analysis 

 Resolve Any Preflight Issues 

 Migrate Mailboxes 

 Apply Licensing 

 Establish Legal Holds 

OIT and Agency Tasks (Joint Responsibility) 
 Velocity Sign-off  

• OIT Sign-off 

• Agency Sign-off 
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DESKTOP PATCHING REQUIREMENTS 
Desktop patching requirements for a successful migration of email to the cloud, whether from 

the EM or the ID Domain include: Security, Operating System and Office patches. 

Note: At a minimum, the patch level should be no older than 6 months.  
 

Web Brower Considerations 
Microsoft has stated that only IE 10 and newer versions of Internet Explorer are supported for 

the Office 365 Email in the Cloud. The newer the browser and its version, the better 

performance can be expected.  

Service Packs and public updates  
The Microsoft Service Pack Support Lifecycle Policy requires you to install Office Service Packs 

within 12 months of its release. Office 365 requires you to be in compliance with this policy. 

Automatic public updates contain critical security fixes for Microsoft products. Office 365 

strongly recommends that customers accept automatic updates from Microsoft both to secure 

their environments and to have the best experience with Office 365. Office 365 ProPlus and 

Lync Basic users can only defer installing updates for 12 months from date of release. 

Network, Firewall & Port Requirement 
In order to connect to OWA and Outlook, make sure you have the following ports through Local 

Area Network (LAN) set up as described below. Most proxy servers, firewalls, and other Internet 

connection sharing methods can restrict port access. If your Agency uses a proxy server, it may 

restrict packets from unknown sources. 

OWA Requirements  
Network Requirement Access to the Internet 
Port Requirements Port 443 to the Internet open 
Outlook Requirements  
Network and Firewall Requirement Access to the Internet 

Port Requirements 
Port 443 to the Internet open 
Port 25 to the Internet open 
Port 80 to the Internet open 
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EMAIL MIGRATION SYSTEM REQUIREMENTS 
The Office 365 requirements in this document are subject to change. This is a living document 

and will be updated as needed. 

COMPONENTS AND REQUIREMENTS 

Operating System: Windows Server 2008 R2  

• Windows 7 – fully patched 

• Windows Server 2012  

• Windows 8  

• 32-bit Office can be installed on 32-bit or 64-bit operating systems and 64-bit Office can 

only be installed on 64-bit operating systems. 

Computer and Processor 

• 1 GHZ or faster x86 or 64-bit processor with SSE2 instruction set. 

Memory 

• 1 GB RAM (32-bit) 2 GB RAM (64-bit) recommended for graphics features, Outlook 

Instant Search, and certain advanced functionality. 

Disk Space 

• 3 gigabytes (GB)  

Monitor Resolution 

• 1024 x 768  
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WEB BROWSERS/OFFICE CLIENTS 
Internet Explorer 11 

• Windows 8.1  

• Windows 7 SP1 or greater 

Internet Explorer 10 

• Windows 8  

• Windows 7 

The latest version of Office - Office 365 ProPlus 

• Windows 8 and 8.1  

• Windows 7 

Office 2010 Service Pack 1 (Service Pack 2 Recommended) 

• Windows 8 and 8.1 

• Windows 7 

Office 2007 with Service Pack 3 

• Windows 8 and 8.1  

• Windows 7 

Office for Mac 2011 with Service Pack 3 

• Mac OS X 10.6 or later 

Mozilla Firefox and Google Chrome 
• The latest version  

Safari 

• The latest version of Safari  

• Mac OS X (any version) 
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WEB BROWSERS: FIREFOX/CHROME/SAFARI 

Office 365 is designed to work with the current or immediately previous version of Firefox, or the 

latest version of Chrome or Safari. Microsoft supports only browser versions that are also 

supported by the browser’s manufacturer. Typically, this is only the most current version. Firefox 

and Chrome are both designed to stream updates to your devices every six weeks. Many 

common problems with these browsers are resolved in the next update. 

System Requirements across Office 365 Plans 

Feature 
Office 365 

Enterprise E3 
Education A3 

Government G3 

Office 365 
Enterprise K1 

Government K1 

Designed to work with Internet Explorer 11 Yes Yes 

Designed to work with Internet Explorer 10 Yes Yes 

Designed to work with Internet Explorer 9 No No 

Designed to work with Internet Explorer 8 No No 

Designed to work with the current or immediately 
previous version of Firefox Yes Yes 

Designed to work with the latest version of Google 
Chrome Yes Yes 

Designed to work with the latest version of Safari Yes Yes 

Designed to work with Office 365 ProPlus Yes Yes 

Designed to work with Office Professional Plus 2013 Yes Yes 

Designed to work with Office Professional Plus 2010 Yes Yes 

Designed to work with Office clients in extended support No No 

Requires installation of Office Service Packs within 12 
months of release Yes Yes 
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OFFICE 365 REGISTRY 
The Office 365 team is requesting that all Agency partners run the following Registry edits for 

the Credential Pop-up and the Connectivity Balloon. The Credential Pop-up edit is 

recommended for each individual account in your Agency. The Connectivity Balloon edit is on 

an as needed basis. 

Credential/Authentication Pop-up 
When attempting to create an Outlook profile or connect to an Office 365 mailbox, you may be 

prompted for credentials multiple times.  

Note: The Credential Pop-up edit is recommended for each individual account in your Agency. 

 

If you cancel the credentials prompt, you receive the following message: 

“The connection to Microsoft Exchange is unavailable. Outlook must be online or connected to 
complete this action.” 

To fix the Pop-up error; 

 Run the following edit on each and every account in your Agency 

• HKEY_CURRENT_USER\Software\Microsoft\Exchange 
Name: NoUIAutoDForSharedMailboxes 
Type: DWORD (32-bit)  
Value: 1 
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Connectivity Balloon 
The second edit is in regards to the connectivity balloon indicating that your account is 

disconnected. This edit only needs to be run on an “as needed basis”. 

If your user is receiving the following pop-ups and you wish to disable the Outlook network 

connectivity balloon; 

 
 Right-click on the Outlook tray icon and uncheck “Show Network Connectivity Changes”. 

 
After closing Outlook the following Registry key is created: 

• [HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Outlook\Display 
Types\Balloons] 
"NetConn"=dword:00000000 

To create a new Group Policy and assign it to users, use the Group policy preferences. 

 Locate the “User Configuration\Preferences\Windows Settings\Registry” 

 Create a new registry item 

To notify Administrators about Exchange Server connection information; 

 Apply this policy only to the normal users 

To increase speed after Group Policy is in effect; 

 Key “Gpupdate /force” on the client machine 

 Restart Outlook 

http://lh5.ggpht.com/-xJDuVf-Cr_M/T822KT5qz7I/AAAAAAAAKSw/q-K_siFqKPs/s1600-h/image[2].png
http://lh4.ggpht.com/-wGkin9MrTsA/T822OOBqr5I/AAAAAAAAKTQ/SXZAAJD4soU/s1600-h/image[14].png
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FILE SIZE  

25MB EXPLAINED 

Prior to January 2015, we asked Agencies to move all emails greater than 25MB to a non-

Exchange location, because anything larger than 25MB could not be migrated to the Cloud. 

The 25MB restriction no longer applies as all mail up to 150MB can now be migrated to the 

Cloud. These larger emails can be viewed, searched and moved, but users are unable to send 

or forward email outside the user’s mailbox. 

Large Items Folder Creation 
The DAS Exchange team is running a scan on all on-premises mailboxes in the Exchange 

environment in order to locate messages over 25MB. Once the scan isolates the large files, they 

will be moved to a “LargeItems” folder at the root of the user’s mailbox.  

Saving an Attachment  
A paperclip icon is displayed for emails containing an attachment.  
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From an email with an attachment(s); 

 Right-click the attachment and select one of the following: 

• Save As – Select this option to save one attachment. 

• Save All Attachments – Select this option to save multiple attachments. 

• Remove Attachment - Select this option to delete the attachment.  

 

If you selected to save the attachment(s), the Save Attachment window is displayed.  

 Scroll to the location where you want to save the file 

 Click OK 

The file is now saved. 
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OFFICE 365 IN VIRTUAL ENVIRONMENTS 
Agencies using RDS (Remote Desktop Services), VDI (Virtual Desktop Infrastructure), or like 

technologies (running in either persistent or non-persistent mode) with Outlook 365 should be 

aware that Outlook in online mode will not provide optimal performance. For this reason, 

operating in Cached Exchange Mode is highly recommended. When running in Cached 

Exchange Mode there is always a local copy of a user’s Exchange mailbox ready in an offline 

data file (.ost file) on the user’s computer.  

By default it is located in the C:\Users\<username>\AppData\Local\Microsoft\Outlook folder. 

 

Consequently, running in Cached Exchange Mode would greatly increase your storage 

requirements for each mailbox instance (as much as 50GB per mailbox).  

One suggested solution is to use the Outlook Web App (OWA); however, the OWA isn’t as 

feature rich or as user-friendly as the desktop Outlook Client. 

The recommended solution is to install Outlook 2013/Office ProPlus with the option to only sync 

the last month of emails, and/or utilize aggressive archive policies that keep the majority of the 

data in the online archive, which is not synced. 
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To follow are the steps to change the cached mode sync range in the individual Outlook 

2013 client: 

From the File Menu; 
 Choose the Account Settings button 

 Select Account Settings  

 

From the Account Settings Dialog Box; 

 Select the Microsoft Exchange account 
 Click Change  
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From the Change Account Dialog Box; 

 Adjust the “Mail to keep offline” sync slider to 1 month 

 

 

 Click Next  
 Click Finish  

When operating in cached mode only some mail will be immediately available to you. However, 

in your mail folder(s) you can see that all of your mail is accessible on the server: 

 

GROUP POLICY CACHED EXCHANGE MODE  
As an administrator for your agency, you can set the Cached Exchange Mode and settings in 

Group Policy. The following Technet article outlines some configuration options: 

https://technet.microsoft.com/en-us/library/cc179175.aspx 

https://technet.microsoft.com/en-us/library/cc179175.aspx
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To configure Cached Exchange Mode settings using 
Group Policy 
In Group Policy; 

 Load the Outlook 2013 template 

 Open the Group Policy Management Console (GPMC) 

In the tree view; 

 Expand Domains 

 Expand Group Policy Objects 

 Right-click the Policy Object  
 Click Edit 

The Group Policy Management Editor window opens. 

In the tree view; 

 Expand User Configuration 

 Expand Administrative Templates 

 Expand Microsoft Outlook 2013 

 Expand Account Settings 

 Click Exchange 

 Expand Exchange 

 Click Cached Exchange Mode 

In the reading pane, in the Setting column; 

 Double click the Policy 

For example, in the Exchange reading pane, open “Use Cached Exchange Mode for new 
and existing Outlook profiles”. 

 Select Enabled 

 Select an option (if appropriate). 

 Click OK 
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OFFICE PROPLUS IN SHARED ENVIRONMENTS 
Many agencies have pcs that are shared by multiple users, while others have deployed user 

endpoints in a virtual desktop environment. To follow are some guidelines on how an agency 

can deploy Office ProPlus in a shared environment.  

Enabling Shared Activation 
The Microsoft Office Deployment Tool, combined with a simple text file, can be used to install 

Office ProPlus on a shared computer and to enable shared computer activation for that 

computer.  

Add the following lines when you create the configuration file: 

<Display Level="None" AcceptEULA="True" />  

<Property Name="SharedComputerLicensing" Value="1" /> 

When Office ProPlus is deployed using a Managed Deployment method such as the Office 

Deployment Tool or SCCM, shared computers would be configured using the above version of 

the configuration file to allow for shared activation. 

After Office ProPlus is deployed and a user signs into an Office ProPlus program (i.e., Word) on 

the shared computer the following occurs: 

Office ProPlus contacts the Office Licensing Service on the Internet to obtain a licensing token 

for the user. To determine whether the user is licensed to use Office ProPlus, the Office 

Licensing Service has to know the user’s account information.  
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 In the State of Ohio deployment this account information is synced through FIM; however, in 

some cases, the user might see the Activate Office dialog box below. 

 

 

 

 

 

 

 

 

If the user is licensed for Office ProPlus, a licensing token is stored on the computer in the 

user's profile folder, and Office ProPlus is activated. The user can now use Office ProPlus. 

Microsoft Office Deployment Tool 
The Microsoft Office Deployment Tool is a command line tool that enables you to download 

Office ProPlus source files and install them on a series of desktops.  

Among other things, it allows an administrator to: 

• Specify the source location for Office 

• Specify version, architecture (32 bit vs 64 bit) and language 

• Manage the update process 
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The Office Deployment Tool executable (setup.exe) has the following options: 

Option Description 

/download Download a full version of ProPlus from the 
Microsoft CDN 

/configure Install ProPlus 
/package Create an app-v package 
/help Get help and options 

The configuration.xml file allows administrators to customize the download and installation and 

allows for the following: 

• Product and languages to install or remove 

• Source path 

• Level of user interface to display 

• Logging options 

• Product updates behavior 

For more information regarding the use of the Office Deployment Tool reference the following  

Technet article: 

http://technet.microsoft.com/en-us/library/jj219422(v=office.15).aspx 

  

http://technet.microsoft.com/en-us/library/jj219422(v=office.15).aspx
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RESOURCE AND SHARED MAILBOXES 
The Office 365 team wants to help facilitate a smooth transition to the State’s new Private Cloud 

service offering. To prepare for the OFFICE 365 migration, Agencies need to identify and 

process all “Shared” and “Resource” mailboxes. 

RESOURCE AND SHARED MAILBOXES 

Shared mailboxes (Resource) in Exchange 2010 

• These mailboxes will migrate as resource mailboxes and no cost is associated.  

• Naming changes may be applied to the mailbox. It is preferred that all Agency resource 

mailboxes begin with the Agency’s three letter prefix, however this is not a requirement 

prior to migrating to Office365. 

• Resource mailboxes cannot exceed a 50GB limit.  

User mailboxes created in Exchange 2010 and 
shared by multiple users 

• It is preferred that all mailboxes shared by multiple users be converted to shared. 

• These mailboxes will migrate to Office 365; however, a monthly cost is associated with 

the mailboxes that have not been converted. 

• Shared mailboxes that are 50GB or less in size do not require a license. If they exceed 

50GB, you will be charged for a full license. 

• In the cloud, user mailboxes being used as shared mailboxes are set up so that a user 

must sign in to his/her own mailbox and then open the shared mailbox using “Full 

Access” permissions. 

Room and equipment resource mailboxes that 
require request approvals 

• If “delegate access” is granted to a user as defined in the Agency AD, for example, 

jsmith, then those delegates will migrate as SOUID. 

• Delegated permissions for individual mailboxes will migrate to Office 365 with no 

changes needed. 
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Tasks to Prepare for Migration 
 Identify all resource mailboxes over the 50 GB limit and cleanup the mailbox.  

 Add the Agency three digit prefix to all resource mailboxes, as needed. 

 Identify all room and resource mailboxes with delegate approvals and make a note of the 

approvers. Delegates may be added to the mailboxes after migration to the cloud. 

 Convert shared user mailboxes to shared resource mailboxes prior to migrating.  

Resource Mailbox Naming  
For naming convention, all resource mailboxes should begin with the Agency three letter prefix.  

After migrating to the cloud, resource mailboxes created in Outlook 2010 may migrate with 

changes to the primary Simple Mail Transfer Protocol (SMTP) address and display the name in 

the Global Address List (GAL). These changes apply to shared, room and equipment 

mailboxes.  

Migrated Resource Mailbox 

GAL: If Agency prefix is used in Outlook 2010, then the prefix will migrate, but no dash 

will be added. For example, DOT Audit Requests 

SMTP Example: audit-requests@ 

How Will Shared Mailboxes Work in Office 365? 
In Office 365, a shared mailbox: 

• Does not have a username and password, so users cannot log on to it directly. A user 

must sign in to their mailbox and then open the shared mailbox using “Full Access” 

permissions. 

• Does not require a license, but each user that accesses a shared mailbox must be 

assigned to a subscription plan. 

• Cannot be accessed by users with Exchange Online Kiosk subscriptions. 

• Has a maximum size of 50 GB.  

• Can be used to store emails sent to and received by the shared mailbox. 

• Can be used to store data migrated from on-premises public folders. 

• Cannot be used to archive emails for individual users. 
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SHARING OUTLOOK CALENDARS 
During your Agency’s migration, project mailbox calendar permissions are migrated with each 

account by default. In the event that permission migration was missed, the following steps can 

be used to set permissions manually. 

These instructions were created using Outlook 2010, but can be used as a reference for 

Outlook 2013 as well. 

Setting Permissions Manually 
 
 Launch the Outlook program and navigate to your Calendars in the Navigation pane.  

 
 
 Select the Calendar you would like to update in the Navigation pane. 

  

Note: If you are not able to change sharing permissions on a calendar, you may not have full 
permissions or “own” the Calendar.  
 
 Click the Calendar Permissions icon.  

 
  



 

  Page 28 
Version 2.3 

 

  

If the name of the person you would like to share the selected calendar with is not already listed; 

 Click the Add button  

Note: If the individuals are already listed and you would like to adjust their permission level 
jump to Step 6.  
 

 
 
 Find the people you would like to have access to your calendar by typing the name in 

the search field.  
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 Select the individual’s name in the list and then select a Permission Level from the drop 

down menu. 

 

 
 

Note: Custom or specific permission levels can be set by editing the options. 
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PERMISSION LEVELS: 

• None - the person cannot see any information related to your calendar 

• Free/Busy time – the person can see when you are free or busy only 

• Free/Busy time, subject, location - the person can see the time, subject, and location 

of your appointments 

• Contributor - the person can put appointments on your calendar but cannot see details 

of existing appointments 

• Reviewer - the person can read everything related to an appointment (except a private 

one) and see folders, but not subfolders 

• Non-editing Author - the person can see appointment details, create appointments (but 

not folders), and delete the appointments they created 

• Author - the person can see appointment details, create appointments, edit 

appointments they created, and delete appointments they created 

• Publishing Author - the person can do everything an Author can, plus create 

subfolders 

• Editor - the person can create items, edit all appointments, delete any appointment, and 

see the full details of all appointments 

• Publishing Editor - the person can do everything an Editor can, plus create subfolders 

• Owner - the person will have the same permissions to your calendar that you have 
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DELEGATING ACCESS  
Delegating access allows users to grant “admin assistant” type permissions. Those who are 

granted “delegate access” are allowed to view, edit, accept, send and respond to mail items on 

your behalf. This access can include the Inbox, Calendar, Tasks, Contacts, and Notes. You can 

select multiple delegates to have access to your account and individually set the permissions for 

each delegate.  

From Outlook; 
 Navigate to the File tab 

 Select the Account Settings icon 

 Choose Delegate Access  
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In the Delegates dialog box; 

 Click the Add button 

 
From the Add Users dialog box; 
 
 Find and add the users to whom you would like to delegate access.  

  
 Select the desired level of delegation for each folder option 
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 Click OK twice 

  



 

  Page 34 
Version 2.3 

 

  

FAXING USING OUTLOOK 

OVERVIEW 

Below are the two methods for faxing from the Outlook\OWA accounts in Office 365. The 

Simple Addressing Scheme only inserts the fax number you are sending to and your email 

address on the cover sheet of the fax. If you require more information on the cover sheet such 

as the recipient’s name, your phone number, company name, etc. then the RightFax Addressing 

Scheme will provide that functionality.  

Example: 

Simple addressing scheme = 6145551212@send.fax 

RightFax addressing scheme= /fax=614-555-1212/voice=614-555=1111/name=First_Last@send.fax 

 

Simple Email Fax Addressing Scheme: 
The Simple Email Fax Addressing scheme allows fax-bound email messages to be addressed 

using a format that is similar to standard Email addressing - <fax number>@domain.com 

Example: 

To send a fax-bound Email message to the fax number 555-1212 with a domain of Send.fax, 

the address format is: 5551212@Send.fax  

  

mailto:6145551212@send.fax
mailto:/fax=614-555-1212/voice=614-555=1111/name=First_Last@send.fax
http://domain.com/
mailto:5551212@Send.fax
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RightFax Addressing Scheme: 
The RightFax addressing scheme allows a great deal of flexibility in how fax-bound email 

messages are addressed.  

Use these rules to address fax messages using the RightFax addressing scheme: 

• The first forward-slash encountered in the address indicates the beginning of the fax 

destination information. 

• Each element of fax information (such as name and fax number) is separated by a 

forward-slash. 

• Addressing elements can appear in any order (i.e., the fax number can come either 

before or after the name). 

• Addressing elements cannot be separated by the RightFax mailbox address itself. 

• A fax recipient name and destination fax number are required. If either element is not 

found, the message is discarded. 

• The last element of fax information must be terminated by either a forward-slash (/), an 

‘@’ symbol, or the end of the line. This allows any character to be part of a fax 

information element, including spaces. 

The following table lists all fax destination elements supported by the RightFax addressing 

scheme. Only the fax number and name elements are required. Except for the fax number, all of 

these addressing elements are used only for display on the fax cover sheet.  

Element Definition Example 
/bi1= Billing code 1 /bi1=1111 
/bi2= Billing code 2 /bi2=2222 
/city= Recipient city, state /city=Tucson, AZ 
/com= Recipient company name /com=Acme, Inc. 
/fax= Destination fax number /fax=555-1212 

/name= Recipient name /name=Jane Doe 
/voice= Recipient voice number /voice=555-4567 

 
Examples: 
/name=Jane/fax=555-1212/ <fax@oit.ohio.gov> 
/fax=5551212/name=Jane/com=Acme/ <fax@oit.ohio.gov> 
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OFFICE 365 MIGRATION TECHNICAL USER 
TRAINING 
Agency staff may already be familiar with Forefront Identity Manager (FIM), an identity 

management software product designed to manage users' credentials and groupings 

throughout the lifecycle of their membership of an enterprise system. Agencies that are currently 

in the ID domain have been using the password reset tool for staff members’ account password  

changes. 

As part of your migration to OFFICE 365, FIM will be used for management, creation, and 

changes of user accounts; therefore, it is necessary for designated Agency technical staff; i.e., 

those who administer user account groups, to attend training on the use of the FIM Portal: 

Forefront Identity Manager, which does require IE for proper functionality. 

There will be multiple sessions available for attendance and we encourage staff to attend at or 

during your pilot phase as well as just prior to your scheduled velocity date. 

OFFICE 365 FIM Portal Training Outline 
User Creation and Portal Overview 
User creation and synchronization  

Logging into FIM Portal 

Home page overview 

Distribution Groups 
Create new distribution groups 

Create new manually populated distribution group 

Manage users 

Manage Owners and Co-Owners 

Create Dynamic Distribution group 

Manage Criteria 

Manage Owners and Co-Owners 

Finding your distribution groups 

Advanced search functions 

Modifying distribution groups 

Manage users 

Manage Owners and Co-Owners 

https://password.ohio.gov/admin
https://sts.ohio.gov/adfs/ls/?wa=wsignin1.0&wtrealm=https%3a%2f%2ffederationportal.ohio.gov%2fInternalSite%2fADFSv2Sites%2ffederationtrunk&wctx=rm%3d0%26id%3dpassive%26ru%3d%252fInternalSite%252fADFSv2Sites%252ffederationtrunk%252fdefault.aspx%253fresource_id%253d18E9EF5C3EDF4CCF84E03554907A3CC5%2526login_type%253d2%2526site_name%253dfederationtrunk%2526secure%253d1%2526orig_url%253dhttps%253a%252f%252fsocfimport02.id.ohio.gov%252fIdentityManagement%252fdefault.aspx%2526URLHASH%253dbd70e33e-7fcc-4319-b47a-948f097f3c0e&wct=2014-10-30T18%3a42%3a00Z&wreply=https%3a%2f%2ffederationportal.ohio.gov%2fInternalSite%2fADFSv2Sites%2ffederationtrunk%2fDefault.aspx
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OFFICE 365 FIM Portal Training Outline 
Manage Criteria 

Manage Owners and Co-Owners 

Deleting distribution groups 

Security Groups 

Create new security groups 

Create new manually populated security group 

Manage users 

Manage Owners and Co-Owners 

Create Dynamic security group 

Manage Criteria 

Manage Owners and Co-Owners 

Finding your security groups 

Advanced search functions 

Modifying security groups 

Manage users 

Manage Owners and Co-Owners 

Manage Criteria 

Manage Owners and Co-Owners 

Deleting security groups 

Managing User Accounts 

Finding user accounts 

Advanced search functions 

Editing user information 

Account Information 

Enable new mailbox 

Enable 

Licensing 

Licensing Office365 account 

Assigning and removing full access permissions 

Assigning and removing send-as permissions 

Hiding mailbox from the GAL 

Resource Accounts – Room, Equipment and shared mailboxes 

Creating new resource account 

Finding resource accounts 
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OFFICE 365 FIM Portal Training Outline 
Advanced search functions 

Editing resource accounts 

Account Information 

Assigning and removing full access permissions 

Assigning and removing send-as permissions 

Hiding mailbox from the GAL 

Calendar options 

Service Accounts 

Creating new service account 

Finding service accounts 

Advanced search functions 

Editing service accounts 

Admin Accounts 

Creating new admin account 

Finding admin accounts 

Advanced search functions 

Editing admin accounts 

Administrator Password Reset 

Accessing password.ohio.gov/admin 

Resetting a user or contractor account password 

Resetting other and county worker passwords 

Resetting admin and service account passwords 

User Self-Service Password Reset 

Accessing password registration site 

Accessing password reset site 
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MOBILE DEVICES 
Agencies must confirm the list of Mobile Devices prior to migration and take steps to remediate 

mobile devices after migrating from EM to ID and/or from ID to the Cloud.  

MOBILE DEVICE SETUP FOR OFFICE 365 
This document details the setup for iPhone and Android devices and is intended for IT Support 

personnel.  

Setting up Email on an iPhone if Using Active Sync 
From the iPhone you are configuring; 

 Select Mail, Contacts, Calendars 

 
 If necessary, Delete the current account 
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To add a new account; 

 Select Mail, Contact, Calendars 

 
 Click Add Account 

 
 Select Exchange  

 
 



 

  Page 41 
Version 2.3 

 

  

 Click Add Account  

 

 Enter the following information:  

• Email – Enter your email address (e.g.: John.Smith@DAS.ohio.gov) 

• Password – Enter your SOUID (myohio.gov) password 

 Choose Next  

 

 

 

 

 

mailto:John.Smith@DAS.ohio.gov
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 It is possible that you will receive the following AutoDiscover error: 

Note: You may be asked for more information in the Advanced Settings. 

 Enter the following information as needed: 

o If migrating from EM to ID: 

Server mail.ohio.gov 

Username Your SOUID@id.ohio.gov 

Password Your SOUID password 

o If migrating from ID to the Cloud: 

Server outlook.office365.com 

Username Your SOUID@id.ohio.gov 

Password Your SOUID password 

 Click Next  

 

Your device will search for the information needed to set up your account.  

mailto:SUID@id.ohio.gov
mailto:SUID@id.ohio.gov
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 Go to the next step when your settings are found  

 Select the features to synchronize with your mobile device 

 Click Save  

Note: By default, Mail, Contacts, and Calendar information are synchronized.  

The iPhone configuration is complete. 

Setting up Email on an Android if Using Active Sync 
You can connect to your Office 365 on an Android phone or tablet. When you set up an 

Exchange account on your Android, you will be able to access and synchronize your email, 

calendar and contacts. If you only want to use email, you can set up POP or IMAP email on an 

Android. If the current account information in not editable, you will need to delete the account 

and re-add it.  

Note: There are several different types of Android devices; therefore, these configuration steps 
and example pictures are to be considered as a general guideline. 

To add a new account from the Android you are configuring: 

 Click the Email icon 

 
  



 

  Page 44 
Version 2.3 

 

  

This application may be named “Mail” on some versions of Android. 

 Click the Mail or Corporate icon. 

 

 Enter the following account information: 

• Email – Enter your email address (e.g.: John.Smith@DAS.ohio.gov) 

• Password – Enter your SOUID (myohio.gov) password 

 Click Next  
 Some devices will ask you what type of account to set up.  

 Choose Microsoft Exchange ActiveSync 

 

 

mailto:John.Smith@DAS.ohio.gov
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 Enter the following as needed: 

 If migrating from EM to ID: 

Server mail.ohio.gov 

Username Your SOUID@id.ohio.gov 

Password Your SOUID password 

 If migrating from ID to the Cloud: 

Server outlook.office365.com 

Username Your SOUID@id.ohio.gov 

Password Your SOUID password 

 Click Next  

 

 

mailto:SUID@id.ohio.gov
mailto:SUID@id.ohio.gov
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As soon as your phone verifies the server settings, the Account Options screen displays. The 

options available depend on the version of Android on your device.  

 Accept the default settings  

 Click Next  

 

 Click Done  
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A message appears, asking if you want to activate device administrator.  

 Click Activate   

 

From the Sync and Connect screen; 

 Click Done to complete the email setup and start using your account 
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Managing Devices with Airwatch  
The instructions below detail the steps for installing Airwatch on an iPhone. However, they can 

also be used for installing Airwatch on an Android device; the steps are not significantly 

different.  

 

From the main screen; 

 Select the App Store  

 

 

 Select the Search icon to look for the Airwatch MDM Agent in the App Store 
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 Install the Airwatch MDM Agent using your existing Apple ID and password 

 

 Click Next  

The Airwatch MDM Agent installs. 

To Configure the Airwatch Application 
 Open the Airwatch application. 
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 Click “Continue without email address”  

 

In the Server text box; 

 Enter the Server URL - mdm.ohio.gov 
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If your Agency uses groups: 

 Enter the appropriate Group ID 

 

Note: The steps below may vary by Agency 

 Complete the end user enrollment 

 Enter the end user’s Active Directory username and password 

Note: iOS will try to autocorrect the end users account name. Double check the input. 
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 Install the MDM Profile 

 

The device prompts you to enter the passcode of the device, after it is entered, the Profile 

installation begins. 

 

The Profile installation is complete. 
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 Enter security information 

 Click OK to allow AirWatch to use your current location 
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For Agencies Using Blackberries 
During the migration, the technical engineer will send a remote wipe command and inform you 

of the time it was sent. If in the event the wipe command is not received (for example; bad 

reception or low battery) the wipe will need to be initiated by the end users or by tier one 

support. 

On the device:  

 Navigate to Options > Security > Security wipe 

OR 
 Visit the following video tutorial: security wipe video 

Note: Anything stored locally on the device will be lost.  

In order to reactivate the device,  

 View the following video: How to Enterprise Activate your BB device 

Note: Your activation password will be your three letter Agency code (for example, DAS) 

When the devices are re-activated on the ID system, the contacts from their Outlook client will 

re-synch with the phone. 

  

https://www.youtube.com/watch?v=xOoWpCUS2Dc
https://www.youtube.com/watch?v=pZ-OKOXszFU
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EMAIL AND CALENDAR DELEGATES 
You may be a delegate to someone else’s mailbox or calendar, or you may have a delegate for 

your mailbox.  

Delegates – Information before Migration 

• During the Office 365 email migration, mailbox owners and their delegates must be 

migrated in the same wave. 

• For most Agencies, delegate permissions will migrate with the mailbox and do NOT have 

to be reapplied. 

ODOT, OBM and ODH 

• Delegate permissions for ODOT, OBM, and ODH users may NOT migrate. Before 

migration, please make a note of your delegates and their permission levels. You may 

then need to reapply them after migration.  

• ODOT, OBM, and ODH users with “Full Send As and Receive” permissions can only be 

reapplied by IT support personnel. If you have a delegate with full access to your 

mailbox or calendar, then those permissions should be noted. After migration, your IT 

support personnel can work with OIT to reassign “Full Send As and Receive” 

permissions. 

• If an ODOT, OBM, or ODH user creates a new profile, they will need to re-add the 

mailbox to their profile.   
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Delegate Permission Levels 
A mailbox owner can determine the access level of each delegate. Delegate permissions can be 

granted to read, create, change and delete items in the owner’s folder. By default, when the 

mailbox owner adds a delegate, the delegate has full access to the owner’s Calendar and Tasks 

folders. The delegate can also respond to meeting requests on the owner’s behalf. 

The mailbox owner can assign delegate permission levels as follows: 

• Reviewer - The delegate can read items in the manager's folder. 

• Author - The delegate can read, create, change and delete items that he or she creates. 

For example, a delegate can create task requests and meeting requests directly in the 

manager's Task or Calendar folder and then send the item on the manager's behalf. 

• Editor - The delegate can do everything that an Author has permission to do and may 

also change and delete the items that the manager created. 

• Full Send As and Receive – The delegate can send emails and meeting invitations as 

the mailbox owner. Emails are NOT sent on behalf of the owner, but as the owner. 

Note: Only Outlook Administrators can assign Full Send As and Receive permissions. 
 

Finding a Mailbox Delegate and Permission Level – 
(ODOT, ODH and OBM) 
ODOT, ODH and OBM users must make a note of their delegates. To view your delegates and 

their permission levels, perform the following steps in Outlook. 

 Select the File tab 

 Select Account Settings  

 Select Delegate Access  

 Choose the name of the delegate  

 Select Permissions  

 Note the permission level assigned to the delegate 

 Continue until you have recorded all of your delegates and their permission levels.  

Note: If a delegate is to receive copies of your meeting requests and responses, they 
need “Editor” permission to your “Calendar” folder. Be sure to select the “Delegate receives 
copies of meeting-related messages sent to me” check box. 
 



 

  Page 57 
Version 2.3 

 

  

Adding Delegates after Migration 

(ODOT, ODH and OBM)  

After migration to the cloud, ODOT, ODH and OBM need to verify that their delegate 

permissions migrated to the cloud. If permissions did not migrate, follow the steps below to add 

the needed delegates. 

 Select the File tab 

 Select Account Settings  

 Select Delegate Access  

 Select Add  

 Key the name of the delegate or search for the name in the search results list 

Note: The delegate must be a person in your organization's Global Address List. 

 Select Add  

 Select OK  

 In the “Delegate Permissions” dialog box, accept the default permission settings or 

select custom access levels for Exchange folders 

If a delegate needs permission to work with meeting requests and responses ONLY, the default 

permission settings are sufficient. You can leave the Inbox permission setting at “None”. 

Meeting requests and responses will go directly to the delegate's Inbox. 

By default, the delegate is granted "Editor" permission to your Calendar folder. When the 

delegate responds to a meeting on your behalf, it is automatically added to your 

Calendar folder. 

To send a message to notify the delegate of the changed permissions; 

 Select the “Automatically send a message to delegate summarizing these 
permissions” check box. 

Note: An option to have the Delegate see private items is available via a checkbox. 
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AUTODISCOVER DNS RECORDS 
During the Office 365 migration, it is important for Agencies who manage their own Domain 

Name System (DNS) to ensure proper name resolution to the mail server(s) responsible for 

accepting and prioritizing mail delivery. 

The AutoDiscover service provides an easy way for the Outlook client application to configure 

itself with minimal user input. AutoDiscover will communicate with the server retrieving the 

necessary user account information allowing the client to be quickly configured. 

If AutoDiscover is not set up correctly, manually created mailboxes using the Outlook client will 

not work after migrating to Office 365. 

Note: Do NOT input this change until the weekend of your scheduled migration! 

Within your DNS forward lookup zone, create the following record type: 

SRV Record - With the following Settings: 

 

From the DNS mmc; 

 Right-click the forward lookup zone 

 Choose “Other New Records...”  
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 Choose Service Location (SRV)  
 Click Create Record…  
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 Enter the settings shown above 

 Click OK 

Note: If your Agency’s DNS is managed by OIT, please inform your lead OIT Exchange 
Administrator so that they can submit this change to the CSC on your behalf. 
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Allowing AutoDiscover 
Once AutoDisover is in place, users may receive the following notifications once they open 

Outlook and log into their email accounts: 

 
 Click Yes 

 
 

 Click to add a checkmark in the “Don’t ask me about this website again”  

 Choose Allow 

To learn how to suppress this pop-up, please reference the following knowledge base article: 

http://support.microsoft.com/kb/2480582 

http://support.microsoft.com/kb/2480582
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ADFS AUTHENTICATION TESTING 
The ADFS Authentication Test requires IE9 or greater. 

 Open Internet Explorer 

 Proceed to the following link: https://adfs.ohio.gov/adfs/ls/IdpInitiatedSignon.aspx 

 Click on “Sign in” 

 

 Enter your ID and password using the following format: 

ID SOUID@id.ohio.gov 
Password SOUID password 

Note: Your State of Ohio User ID (SOUID), formerly known as OAKS ID, is an 8-digit number. 

If you can successfully log on, then the ADFS Authentication test was successful. 

 

  

https://adfs.ohio.gov/adfs/ls/IdpInitiatedSignon.aspx
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OFFICE 365 – ARCHIVE & RETENTION 
POLICIES AND SCHEDULES 

ARCHIVE & RETENTION POLICIES 
Archive and retention policies can be applied at the Agency level or by users for their mailbox. 

Agency archive and retention policies in OIT’s Exchange environment will migrate to the cloud. 

These policies will be disabled the first 30 days in the cloud to allow for verification that all data 

planned to be migrated has been migrated. After 30 days, the Archive and Retention policies 

will be re-enabled. 

Individuals may have created personal archive and retention schedules. These personal archive 

and retention settings will not migrate. 

RECREATE POLICIES  
An Agency may choose to have their current policies recreated in the cloud. The pre-migration 

checklist will allow you to select this option. 

CREATE NEW POLICIES  
Agencies that do not currently have archiving turned on may do so after migration. To learn 

more about archive and retention schedules for Ohio, see the next section.  

ARCHIVE AND RETENTION SCHEDULES 
The State maintains a General Schedule List of archive and retention policies for statewide 

compliance. In addition, Agencies and commissions may have Agency-specific schedules. 

To view or research state schedules - http://apps.das.ohio.gov/rims/default/Default.asp 

At the Records Management page; 

 Choose the “Public enter here for General Schedules or Search” link on the left side of 

the Records Management screen. 

http://apps.das.ohio.gov/rims/default/Default.asp
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 Contact DAS to log into the site with an account and password 

 
At the State of Ohio Records Management page: 

 Click on the “General Schedule List”  

 
 View Agency specific schedules or all statewide schedules by category 
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TERMS AND DESCRIPTION FOR OFFICE 365 

AGENCY WHITE GLOVE LIST  
The White Glove List is a list of users who the Agency needs to treat differently than other email 

users. These individuals will get special attention throughout the migration, ensuring their email 

capability is always working.  In most cases, the White Glove List is the executive team and 

potentially their administrative assistants. A few Agencies have included their Service Desk staff 

and key technical staff necessary. Agencies identify and supply the White Glove List. 

DO NOT MIGRATE LIST 
In the event you have an application that does not use SMTP or Relay and you cannot 

remediate in time for migration, please notify us with the list of mailboxes prior so we can put 

them on a “Do Not Migrate” list. There are no other reasons for leaving a mailbox behind. 

IN-PLACE HOLD VS. LITIGATION HOLD 
When a reasonable expectation of litigation exists, Agencies may be required to preserve email 

that is relevant to the case. There are two options that can be used to specify the type of “hold” 

that needed to apply to your Agency’s mailboxes: 

• Litigation Hold - Only allows the entire mailbox to be placed on hold with a specified 

duration period to hold items. The duration is calculated from the date a mailbox item is 

received or created. If a duration is not set, items are held indefinitely or until the hold is 

removed. 

• In-Place Hold - Provides a more granular hold capability. The hold can be based on 

query parameters with the ability to place multiple holds on one mailbox.  

Example Scenarios:  
If a mailbox is placed on one or more In-Place Hold AND on Litigation Hold (without a duration 

period) at the same time, all items are held indefinitely or until the holds are removed 

If Litigation Hold is removed and the user is still placed on one or more In-Place Hold(s), items 

matching the In-Place Hold criteria are held for the period specified in the hold settings. 
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When migrating a mailbox that is on Litigation Hold from one server environment to another (in 

this case from EM to ID and/or from ID to the Cloud), the Litigation Hold setting continues to 

apply, ensuring that compliance requirements are met during Licensing Types. 

 
All licensing requirements have been contracted through an Enterprise Agreement. There are 

two types of licenses used with Office 365 email to the cloud: 

• Full license that allows a user to use the product locally and remotely to its fullest extent. 

• Light license facilitating a casual user access to email through a Kiosk arrangement. 

This is essentially a share environment facilitating casual user use at a very low cost. 

The Agency determines who is a full function or kiosk account. DAS has acquired enough 

licenses to accommodate both. The difference from an Agency perspective is the enterprise 

charge back cost for either type.  

EMAIL APPLICATION ASSESSMENT 
Fully explained below, each Agency must evaluate their applications incorporating email within 

the applications. The Office 365 dependencies are described below. 

EMAIL APPLICATIONS DEPENDENCIES  
Agencies using Relay (SMTP – Simple Message Transfer Protocol) are good to go for email 

migration to Office 365 in the cloud. The address that is in use today is not changing or going 

away. Any application that uses any other transfer mechanism must be remediated prior to 

moving email to the cloud. 

Example: 

• Does it log-in to the mail system using credentials? 

• Does it use EWS (Exchange Web Services)? 

• Does it use POP or IMAP? (POP and IMAP are not supported as they are unsecure, 

need to use SPOP and SIMAP) 

• Should there be insufficient time to remediate prior to the scheduled date for your 

Agency migration; the application can be left behind in the EM Domain. However, prior 

to allowing the Agency to migrate email to the cloud, we need realistic dates and 

commitment when the application(s) will be remediated. 
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ENCRYPTION POLICY AND PRODUCT USE 
• ZIX will remain the Encryption Policy of use minimally through July 2015. 

• The current Microsoft offering cannot be effectively administered in its current state. 

• Microsoft is actively enhancing the encryption rules and management strategy of those 

rules. The State of Ohio will deploy the Microsoft encryption tool, once the 

enhancements fulfill the State of Ohio’s requirements. 

SEND AS / SEND ON BEHALF  
There has been confusion around the Send As function vs. the Send on Behalf function.  

• Send As: DAS can set a server setting that allows someone to send email as a specific 

individual. The recipient would not know that the email was actually sent by someone 

different than the name on the email. 

• Send of Behalf: In this instance, it is very clear that the sender is acting on behalf of or 

sending something for that named individual in the email. The recipient would recognize 

that the email came from a sender of a different name, but on behalf of another 

individual. 

DISTRIBUTION GROUPS 
• Distribution Groups – Distribution groups are used to define who should be included in 

group messages. They are primarily used with email applications to send email to 

collections of users. Distribution groups are NOT security enabled. 

• Security Groups – Security groups are used to control access to resources. For 

example, an administrator can create a security group to grant a group of people access 

to a Shared Calendar or Resource Calendar.  

• Mail Enabled Security Groups – Mail enabled security groups are used to disseminate 

information to all the members within a security group. For example, a group of technical 

staff requiring elevated privileges to specific servers also need to receive information 

regarding server outages. 

Note: Agencies should be aware of the Distribution Groups that are being used as well as how 
they are being used. Any Distribution Group that is being used for setting permissions to shared 
resources will need to be converted to a Security Group. 
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DISPLAY NAMES 
Once an account migrates to ID or O365, the user account information is directly tied to the 

OAKS payroll system thereby pulling those attributes into the email system. What does this 

mean to the user? If a user’s given name is different than what the current email address 

displays then there will be a Display Name change required. Display Names can be changed in 

the FIM tool and this task can be performed by the agency’s IT Staff. 

 

FREE/BUSY 

After an account migrates to O365 there will be some calendar viewing changes. In O365, the 

default calendar permission is set to Free/Busy for all accounts.  
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If you previously had granted specific calendar viewing permissions to other users, those same 

permissions should apply; however, accounts that still reside in the on-premises solution may 

not be able to access the data and vice versa.  

PASSWORD EXPIRATION EMAILS  

If you receive a message titled: “Please change your State of Ohio User ID password” that looks like the 

displayed message, it is a legitimate message and is a new feature within our Identity Management and 

Cloud systems. These messages are auto-generated when passwords are within 14, 7, 5, 3 and 1 day(s) 

of expiration. When you receive these messages, it is highly recommend that you change your password 

as soon as possible. If your password does expire, you will be locked out of your email. Please also be 

aware that when you change it, you may need to log out of your email client so that it will prompt you 

for your new password.  

If you have a state-owned iPhone, you will also need to change your email password under 

SettingsMail, Contacts, and Calendars Exchange ActiveSync.  
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LOGON CREDENTIAL CHANGES FOR EM 
DOMAIN USERS 
For Agencies that are currently in the EM Domain, it is important to start communicating logon 

credential changes that will go into effect once accounts are migrated to OFFICE 365 

Below is an example of a potential communication: 

 Know your State of Ohio User ID (SOUID) 

Note: SOUID = State of Ohio User ID = MYOHIO.GOV ID 

 Be sure your State of Ohio User ID password is current. If you have received notice that 

your password needs to be reset, make and test the change before migration.  

ID SOUID@id.ohio.gov 

Password SOUID password 

Example 10010100@id.ohio.gov 
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OFFICE 365 CHANGING YOUR PASSWORD 
Access to your email account is tied directly to your State of Ohio User ID (SOUID). It is very 

important that you remember your SOUID and that you properly maintain your OAKS account 

information.  The first time use of a SOUID password must be set up by the OAKS Helpdesk at 

614.644.6625 or 1.888.OhioOAK (1.888.644.6625). 

Once you have logged into your OAKS account for the first time, it is best practice to 

immediately set up at least two primary email addresses and to create your Forgotten Password 

question. 

ESTABLISHING PRIMARY EMAIL ADDRESS 
 Access the myOhio.gov website at: myOhio.gov  

 Enter your SOUID and password when prompted 

 Select My Info  

 Select Email Addresses  

 

 Enter at least two email addresses and mark them both as Primary accounts. 
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 Click OK to save 

Note: In the event that you must use the “Forgot Password” link on the homepage, OAKS must 
be able to send a temporary password to an account other than your work address: 

 

The following “Change or Set Up Forgotten Password Help” and “Changing My Password” 

instructions are available at http://myohio.gov.  

 

http://myohio.gov/
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MIGRATING FROM EM TO IDENTITY USER 
EXPERIENCE 
On the first day of your agency’s EM to ID migration mailbox users will likely experience the 

following popups and will need to follow these steps in order to have minimal impact and 

successfully log into their accounts. 

On Day 1 of your migration: 

 Log into your outlook client with your pre-migration credentials 

(firstname.lastname@agencyname.ohio.gov, or ODNNT\firstname.lastname) 

Once logged in you will see a similar pop-up:   

 Ensure that you select “Don’t ask me about this website again” and select Allow 

 

Next you will see the following pop up.  

 Select OK 

 

mailto:firstname.lastname@agencyname.ohio.gov
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To close out of Outlook; 

 Select File  

 Select Exit  
 Re-open Outlook 

You should see a Windows Credential Dialog Box pop up.  

 Enter your new Outlook credentials: SOUID@id.ohio.gov along with your myohio.gov 

password. 

 

Note: You can check the “Remember my credentials” box in order for Outlook to store your 
password. 

Once you enter your credentials; 

 Verify that you are connected by looking in your status bar.  

 

You may see either of the following statuses: 

 

 

If for any reason your account will not authenticate, follow these troubleshooting steps prior to 

contacting your agency’s helpdesk. 

mailto:SOUID@id.ohio.gov
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 Verify that your password is correct by logging into the myohio.gov website 

 Log into the Outlook Web App (OWA) at https://mail.ohio.gov and verify that you can 

access your mail from the server 

 If an OWA error occurs, such as “no user found,” try to log onto the old Outlook Web 

App page at mail.em.ohio.gov using your old credentials: 

firstname.lastname@agencyname.ohio.gov  

OR 

firstname.lastname@agencyname.state.oh.us 

This will test whether your account successfully migrated 

 Contact your agency’s help desk for further assistance 

ADVANCED TROUBLESHOOTING FOR AGENCY 
HELP DESK 

Mailbox Repair 
 Close Outlook completely by going to File > Exit 
 Open the Control Panel 

 Select the Mail (or Mail32bit) icon 

 Click on Email Accounts  

 Select the email account with the user’s primary SMTP address 

 Click the Repair button 

The repair will find the account using Auto-Discover and then prompt you for credentials. 

If the account is not found; 

 Proceed to New Profile Setup below 

 Enter the SOUID@id.ohio.gov credentials (using the user’s actual SOUID) 

 Click Next  
 Click Finish  

 Enter the credentials once again (SOUID@id.ohio.gov) 

New Profile Setup 
 Close Outlook completely by going to File > Exit 
 Open the Control Panel 

https://myohio.oaks.ohio.gov/
https://mail.ohio.gov/owa/auth/logon.aspx?replaceCurrent=1&url=https%3a%2f%2fmail.ohio.gov%2fowa%2f
https://mail.em.ohio.gov/CookieAuth.dll?GetLogon?curl=Z2F&reason=0&formdir=1
mailto:firstname.lastname@agencyname.ohio.gov
mailto:firstname.lastname@agencyname.state.oh.us
mailto:SOUID@id.ohio.gov
mailto:SOUID@id.ohio.gov
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 Select the Mail (or Mail32bit) icon 

 Click on Show Profiles  

 Remove any previous profiles if necessary 

 Click Add  

 Create a profile name. A name such as “Outlook365”  

 Enter the user’s email address and Account name (Lastname, Firstname)  

 Click Next  
The account will be found using AutoDiscover 

 Once found it will prompt you for credentials.  

 Enter your SOUID@id.ohio.gov 

 Click Next 
 Click Finished 

If these steps are not successful, please contact your lead migration engineer. 

  

mailto:SOUID@id.ohio.gov
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OUTLOOK AUTO-COMPLETE CACHING 
After a mailbox migration it is possible that a user will receive non-deliverable mail item 

messages after attempting to send or to respond to an email address that has been cached. 

This can be fixed one at a time or it can be fixed by completely emptying the Auto-Complete 

Cache. 

Removing One Cached Address at a Time: 
From a new mail message; 

 Key the recipient’s name in the To field 

 Allow the Auto-Complete list to pop up 

 

From there, press the down arrow key and then DELETE or click the X to the right of the name 

that you want to remove. 

This step will allow you to remove a single item that is no longer needed or is not properly 

working. 

Emptying the Entire Auto-Complete Cache: 
From your Outlook mailbox; 

 Select File  

 Select Options  
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In the Options Dialog box; 

 Navigate to the Mail setting on the left-hand side 

 Scroll down to the Send Messages section 

 Click the Empty Auto-Complete List button 

 

 

 

 

 

 

 

Once this step is complete you will need to select names from the address book or type the 

whole email address to address a message. It will then begin to re-populate the list. 

Note: if you choose to empty the entire Auto-Complete List, it will clear ALL of the items in your 
cache. If you do not have commonly used external addresses saved as contacts, these 
addresses will be deleted. 

An alternate way to empty the cache is to start Outlook at the command line: 

Start > Run > type outlook.exe /cleanautocompletecache and click Enter.  

On Outlook startup, it will be loaded without cached entries. (Be sure that there is a space 

between the .exe and the /) 
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EMPLOYEE ONBOARDING, OFFBOARDING 
AND TRANSFERS 
Technical procedures for Agency onboarding, offboarding and transfers are discussed in depth 

in the FIM Portal Training seminar and refresher course.  

The following memos and flowchart are included to provide basic information and guidance for 

email when employees are transferring between Agencies.  
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EMPLOYEE INTER-AGENCY TRANSFER  
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EMAIL PROCESS FLOW FOR TRANSFERRING 
EMPLOYEES 
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EMPLOYEE INTER-AGENCY TRANSFER GUIDE 
FOLLOW-UP 
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SLA FOR INCIDENT AND PROBLEM 
MANAGEMENT 
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ESCALATION PROCEDURES 
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PILOT ACTIVITIES AGENCY - POC EMAIL 
COMMUNICATION 
In the days before your pilot of Outlook 365, please create and supply OIT with your list of pilot 

users including name, email address, and SOUID 

 Communicate to your pilot group regarding their user experience: 

 You will have a new way to log into your email account  

 Confirm Checklist items completion 

OFFICE 365 Agency Engagement Pilot 
Recommendations, Requirements, Activities, User 
Acceptance Tests Expectations and Potential 
Agency Testers 

PILOT 
• An Office 365 Pilot is scheduled 3 or 4 weeks prior to the Velocity Date for email 

migration to the cloud. The 3 or 4 weeks out is entirely dependent on whether it is a 1 or 

2 week pilot. We collectively arrive at which time interval is appropriate for your Agency. 

• Once the pilot is completed, there is always a week hiatus prior to the actual Velocity 

date, primarily to clean up any discovered issues. 

• The intention of the pilot is to exercise Office 365 in the cloud as your Agency uses email 

today with the expressed intent of surfacing any issues germane to your Agency’s use. 

• Pilot participants selection should represent a cross section of diverse users, reflective of 

how your Agency uses mail. This diversity also drives the number of participants. 

Agencies have selected as few as 10 to as many as 50. 

• It is very important that if you pick an executive, that you also have that person’s 

administrative assistant participate. If one or the other is left in the existing domain, 

he/she will not be able to view the other user’s calendar. 
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PILOT GO LIVE CHECKLIST 

PILOT GO LIVE CHECKLIST 

☐ All accounts on the Pilot User List have been migrated 

☐ All Pilot User Mailboxes have active licenses 

☐ All Pilot User Client Mailboxes are activated and connected 

☐ All [AgencyName] technical support employees have received training in FIM Portal and 
have the proper permissions 

PILOT WEEK CHECKLIST  

☐ All Pilot User accounts have been signed into and are being used 

☐ Pilot members have completed UAT to the satisfaction of the [AgencyName] 

☐ OIT and [AgencyName] have identified and remediated Pilot migration issues 

☐ All Pilot Users with Mobile Devices have activated devices 

☐ There are no roadblocks hindering [AgencyName] from moving forward 

AGREEMENT 
We, AgencyName, agree that all Pilot Checklist Activities have been completed and we agree 

that both OIT and [AgencyName] are ready to move forward to the next step [VELOCITY] in 

Phase One of the OFFICE 365 Migration process.  

We would like to schedule a tentative Velocity date for [AgencyName] to be migrated to Outlook 

365. 

Tentative Velocity Date: [InsertDate] 

Agency Point of Contact Signature: ____________________________________ 

OIT Point of Contact Signature: _______________________________________ 
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USER ACCEPTANCE TESTING: 
We have provided a set of scripts for your Agency to exercise the various functionality of the 

Office 365 email in the Cloud. 

These scripts were created by Microsoft and not intended to exercise every piece of 

functionality but to use the product as most people use it daily. 

Our suggestion is to have an active email user (i.e. administrative assistant) go through each 

step of the script. We have uncovered some issues with the product during the testing. 

Note: It is a required migration task for Agencies to step through each script. 
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Offline address book 

Test case number 4.1.1 

Resource name   

Date  

User scenario 

From the online mailbox, download and access to offline address book. 
Select the Send and Receive tab 
Select the down arrow for the Send/Receive Groups 
Select Download Address Book from the menu 
Leave the default settings and click OK 

Method  

Expected results Able to download and view content of offline address book. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Folder Search 

 
 
 
  

Test case number 4.1.2 

Resource name   
  

Date  

User scenario From the online mailbox, setup a search folder to filter emails. 

Method  

Expected results Search result returned after successful search. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Send/Receive 

Test case number 4.1.3 

Resource name   
  

Date  

User scenario 
From an online mailbox (mailbox that has been migrated to the cloud), send an 
email to an on-premises (mailbox on OIT servers) recipient and another online 
recipient. 

Method  

Expected results Successful email deliveries. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Reply 

Test case number 4.1.4 

Resource name   

Date  

User scenario From an online mailbox, reply an email to an on-premises recipient and to another 
online recipient. 

Method  

Expected results Successful delivery of reply. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Forward 

Test case number 4.1.5 

Resource name   
  

Date  

User scenario From an online mailbox, forward an email to an on-premises recipient and an 
online recipient. 

Method  

Expected results Successful forward of email. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Distribution List 

Test case number 4.1.6 

Resource name   

Date  

User scenario From an online mailbox, send an email to a distribution list. 

Method  

Expected results Successful delivery of email to distribution list. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Attachment Size 

Test case number 4.1.7 

Resource name   

Date  

User scenario From an online mailbox, send an email with an attachment that is over the size 
limit. 

Method  

Expected results Failed delivery of the email with the oversize attachment. 

Pass/fail  

Observed results  

Environment  

Comments or information  

 
Address Book: recipient properties 

Test case number 4.1.8 

Resource name   

Date  

User scenario From an online mailbox, open the address book and view the properties of a 
recipient in the address book. 

Method  

Expected results Successfully retrieve the properties of the recipient in the address book. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Folders 

Test case number 4.1.9 

Resource name   

Date  

User scenario Online mailbox creates a new folder, rename the folder and move the folder. 

Method  

Expected results Successful folder operations. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Move/Copy Mail Items 

Test case number 4.1.10 

Resource name   
  

Date  

User scenario Online mailbox, copy mail items and move mail items. 

Method  

Expected results Successful move and copy of email items to different folders. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Deleted Items 

Test case number 4.1.11 

Resource name   

Date  

User scenario 
Online mailbox, delete mail and empty deleted Items folder. 
From the Outlook Folder tab, select Recover Deleted Items in the Clean-up area 
Select the items that you want to recover, then click the Recover Selected Items 
button 

Method  

Expected results Successful deletion of email and a clean deleted items folder. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Deleted item recovery 

Test case number 4.1.12 

Resource name   

Date  

User scenario Online mailbox, execute "Recover Deleted Items" functionality. 

Method  

Expected results Deleted items listed in the “Deleted Items” folder. Able to recover any of the deleted 
items. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Out-of-office notifications   

Test case number 4.1.13 

Resource name  

Date  

User scenario Online mailbox, setup an out-of-office (OOF) notification. Ensure that OOF 
notifications are sent. 

Method  

Expected results Only internal users will get an OOF message from the test user. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Email disclaimers   

Test case number 4.1.14 

Resource name To be completed by Agencies that uses an email account with a disclaimer.  
 

Date  

User scenario Send an email from an online mailbox to an Internet recipient; ensure that the email 
is tagged with the correct Ohio disclaimer. 

Method  

Expected results The email sent must be attached in line with the correct disclaimer. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Scheduling assistant: free/busy online mailbox to on-premises 

Test case number 4.2.1 

Resource name   

Date  

User scenario Use scheduling assistant to view free/busy from an online mailbox to an on-
premises mailbox. 

Method  

Expected results Ensure results are confirmed about user’s availability in their schedules. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Scheduling assistant: free/busy on-premises to online mailbox 

Test case number 4.2.2 

Resource name  

Date  

User scenario Use scheduling assistant to view free/busy from an on-premises mailbox (mailbox to 
OIT servers) to an online mailbox (mailbox that has been migrated to the cloud). 

Method  

Expected results Ensure results are confirmed about user’s availability in their schedules. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Send meeting request 

Test case number 4.2.3 

Resource name   

Date  

User scenario From on-premises mailbox, send meeting request to online mailbox. 

Method  

Expected results Successful meeting request delivered to online mailbox. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Accept meeting request send 

 
 
 
 
 
 
  

Test case number 4.2.4 

Resource name  

Date  

User scenario From the online mailbox, accept the meeting request. 

Method  

Expected results Successful return of meeting acceptance. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Decline meeting request 

Test case number 4.2.5 

Resource name   

Date  

User scenario From the online mailbox, send a meeting request to an on-premises mailbox. At the 
on-premises mailbox, decline the meeting request. 

Method  

Expected results Successful return of declined meeting request. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Request to distribution list 

Test case number 4.2.6 

Resource name   

Date  

User scenario Online mailbox, send a meeting request to a distribution list. 

Method  

Expected results Successful delivery of meeting request to distribution list. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Recurring meeting request 

Test case number 4.2.7 

Resource name   

Date  

User scenario From the online mailbox, send a recurring meeting request to an on-premises 
mailbox. 

Method  

Expected results Successful creation of weekly recurring meeting. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Send and read email 

Test case number 4.3.1 

Resource name   
 

Date  

User scenario From an online mailbox, send an email using Outlook Web App. 

Method  

Expected results Successful delivery and viewing of email. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
 
 
 
 
 
  



 

  Page 101 
Version 2.3 

 

  

Preview pane 

 
Free/busy and meeting request 

Test case number 4.3.3 

Resource name   
 

Date  

User scenario View free/busy and send a meeting request from an online mailbox to an on-
premises mailbox via Outlook Web App Outlook. 

Method  

Expected results Successful delivery of a meeting request. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
 
 
 
 
  

Test case number 4.3.2 

Resource name   

Date  

User scenario On the online mailbox, read mail using preview pane via Outlook Web App. 

Method  

Expected results View email in preview pane. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Attachments 

Test case number 4.3.4 

Resource name   

Date  

User scenario Send email with an attachment from an online mailbox using Outlook Web App. 

Method  

Expected results Successful delivery of email with attachment to recipient. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Move messages 

Test case number 4.3.5 

Resource name   

Date  

User scenario On the online mailbox, move messages between folders via Outlook Web App. 

Method  

Expected results Messages moved to folder. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
 
 
 
 
 
  



 

  Page 103 
Version 2.3 

 

  

Scheduling assistant 

Test case number 4.3.6 

Resource name   

Date  

User scenario On the online mailbox, create an appointment on the calendar by using the 
scheduling assistant in Outlook Web App (OWA). 

Method  

Expected results Successful view availability via the OWA calendar. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Spell checker 

Test case number 4.3.7 

Resource name 
  
  
  

Date  

User scenario 
Use spell checker in Outlook Web App in an online mailbox. 
 
Outlook Web App relies on your web browser for checking spelling. Right-click the 
word you want to check and select the correct spelling from the side menu. 

Method  

Expected results Find incorrect word and be able to correct the spelling. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Exchange control panel 

Test case number 4.3.8 

Resource name   

Date  

User scenario Configure options in the mailbox using Outlook Web App (OWA). 

Method 

Open mailbox Office 365 exchange online using OWA. 
 
On the top right hand side of your screen, click on the drop down menu next to 
options. 
 
Select “see all options.” Once options page opens, notice the change in address 
bar should change to “ecp” instead of “owa.” 
 
Click on organize emails on the left hand side and click on delivery reports in the 
middle pane. 
 
Try to search for a message you have sent to some other user who is on Office 
365. 

Expected results You should be able to see the delivery report of the message with details; with this 
working you can consider ecp as working component. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
  



 

  Page 105 
Version 2.3 

 

  

Access shared calendar 

Test case number 4.4.1 

Resource name   

Date  

User scenario Check delegated user is able to access the shared calendar. 

Method 

Move the mailboxes one. Where delegation is assigned two. Who has been 
assigned delegation? 
 
Log-in to Outlook with user who has been assigned delegation. 
 
Access other user’s calendar. 
 
Try to perform operation as of the level of delegation example create calendar item 
or send meeting request on behalf of the user. 
 

Expected results User should be able to access other user’s calendar and create or delete meeting 
request. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Send on Behalf 

Test case number 4.4.2 

Resource name  

Date  

User scenario Send email on behalf of another user. 

Method 

Move the mailboxes one. Where delegation is assigned two. Who has been 
assigned delegation on inbox? 
 
Log-in to Outlook with user who has been assigned delegation. 
 
Open other user’s mailbox folder (inbox). 
 
Create a new mail item and from option choose show from field. 
 
In from field, type the user name of the mailbox where delegation is assigned. 
 
Sent to other mailbox or the mailbox who has been assigned delegation. 
 
Check the email and it should appear as “Send On Behalf of <user>” 
 

Expected results User should be able to send mail on behalf of other user where delegation is 
configured and mail should appear as “Send on behalf.” 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Send As 

Test case number 4.4.3 

Resource name  

Date  

User scenario Send email with ‘Send As’ another user. 

Method 

Move the mailboxes one. Where Send As permissions are given two. Who has 
been assigned Send As permissions? 
 
Log-in to Outlook with user who has been assigned Send As permissions. 
 
Create a new mail item and from option choose show From field. 
 
In From field type the user name of the mailbox where Send As is assigned. 
 
Sent to other mailbox or the mailbox who has been assigned delegation. 
 
Check the email and it should appear as if it is sent from user where Send As 
permissions where configured. 
 

Expected results 
User should be able to send mail on behalf of other user where Send As is 
configured and mail should appear as if the mail was sent by mailbox where Send 
As permissions were configured. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Full secondary mailbox access  

Test case number 4.4.4 

Resource name   

Date  

User scenario Opening and accessing a secondary online mailbox with full access rights. 

Method 

Move the mailboxes one. Where full mailbox access permissions are given two. 
 
Who has been assigned Full Mailbox Access permissions? 
 
Configure profile to open other user’s mailbox. 
 
Option is available in ProfileMore SettingsAdvance. 
 
Log-in to Outlook with user who has been assigned full mailbox access 
permissions. 
 

Expected results Two mailboxes should be opened in same outlook profile without retyping any 
credentials. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Rules 

Test case number 4.4.5 

Resource name   

Date  

User scenario Create and use inbox rules in an online mailbox. 

Method 

Create some server side rules inside the mailbox. 
 
Open the mailbox from Office 365 Exchange online. 
 
Test rules are working. 
Server-side rules are handled entirely by the Exchange Server, independent of the 
state of the Outlook client.  For example, forward email (sent from user on the 
Exchange server) to another mailbox (recipient mailbox must also reside on the 
Exchange server). 
Client-only rules do not execute until the user who created the rule, logs into the 
Outlook client with the same profile used to create the rule. For example, mark all 
emails with certain text in the subject line as urgent. 
 

Expected results All the rules should be working successfully and should work as expected. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Configuring a new device 

Test case number 5.1.1 

Resource name  

Date  

User scenario Configure a Windows Phone to synchronize with a new mailbox in Office 365 via 
the cloud’s AutoDiscover service. 

Method   

Expected results The mobile device should configure itself through the AutoDiscover settings and 
successfully synchronize with the online mailbox. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Re-configuring ActiveSync post-migration 

Test case number 5.1.2 

Resource name   

Date  

User scenario Re-configure a configured Windows Phone to synchronize with the migrated 
mailbox in Office 365 via the cloud’s AutoDiscover service. 

Method   

Expected results The mobile device should configure itself through the AutoDiscover settings and 
successfully synchronize with the online mailbox. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Receive mail and attachment on mobile device 

Test case number 5.1.3 

Resource name   

Date  

User scenario Send email from an online mailbox to the Windows Phone user’s mailbox with 
attachment. View mail and attachment on the mobile device. 

Method   

Expected results Successful delivery of email to the mobile device and be able to view both email 
and attachment on the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Send mail from mobile device 

Test case number 5.1.4 

Resource name   

Date  

User scenario Send email from the mobile device to both an internal user and an external user. 

Method   

Expected results Successful delivery of email to both the internal and external user. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Accept a meeting request 

Test case number 5.1.5 

Resource name  

Date  

User scenario 
Send a meeting request from an online user to a mobile device user, accept the 
meeting request. Check the meeting is booked in the calendar of the mobile 
device. 

Method   

Expected results Accept the meeting request from the mobile device and see the meeting is booked 
in the Exchange calendar.  

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Propose new time on meeting request 

Test case number 5.1.6 

Resource name   
  

Date  

User scenario Send a meeting request to a mobile device user; from the mobile device propose a 
new meeting timing. 

Method   

Expected results Successful receipt of the proposed new meeting timing by the meeting organizer. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Decline meeting request 

Test case number 5.1.7 

Resource name   

Date  

User scenario Send a meeting request to a mobile device user; from the mobile device decline 
the meeting request. 

Method   

Expected results Successful receipt of the declined meeting notification by the meeting organizer. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Calendar sync 

Test case number 5.1.8 

Resource name   

Date  

User scenario On the mobile device user’s calendar, mark an appointment in the default calendar 
using Outlook or Outlook Web App. 

Method   

Expected results Calendar appointment successfully synced to the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Contact sync 

Test case number 5.1.9 

Resource name   
 

Date  

User scenario On the mobile device user’s contact folder, create a new contact using either 
Outlook or Outlook Web App. 

Method   

Expected results New contact successfully synced to the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Microsoft Exchange Global Address List 

Test case number 5.1.10 

Resource name   

Date  

User scenario On the mobile device, perform a lookup for a user entry in the Microsoft Exchange 
Global Address List and send an email to the entry. 

Method   

Expected results Perform the user search successfully. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Configuring a new device 

Test case number 5.2.1 

Resource name   

Date  

User scenario Configure an iPhone/iPad device to synchronize with a new mailbox in Office 365 
via the cloud’s ActiveSync service. 

Method   

Expected results The mobile device should successfully synchronize with the online mailbox after 
the configuration. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Re-configuring ActiveSync post-migration 

Test case number 5.2.2 

Resource name   

Date  

User scenario Re-configure a configured iPhone/iPad to synchronize with the migrated mailbox in 
Office 365 via the cloud’s ActiveSync service. 

Method   

Expected results The mobile device should successfully synchronize with the online mailbox. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Receive mail and attachment 

Test case number 5.2.3 

Resource name  

Date  

User scenario Send email from an online mailbox to the iPhone/iPad user’s mailbox with 
attachment. View mail and attachment on the mobile device. 

Method   

Expected results Successful delivery of email to the mobile device and be able to view both email 
and attachment on the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Send mail from iPhone/iPad 

Test case number 5.2.4 

Resource name  

Date  

User scenario Send email from the iPhone/iPad to both an internal user and an external user. 

Method   

Expected results Successful delivery of email to both the internal and external user. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Calendar sync 

Test case number 5.2.5 

Resource name  

Date  

User scenario On the mobile device user’s calendar, mark an appointment in the default calendar 
using Outlook or Outlook Web App. 

Method   

Expected results Calendar appointment successfully synced to the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Contact sync 

Test case number 5.2.6 

Resource name  

Date  

User scenario On the mobile device user’s contact folder, create a new contact using either 
Outlook or Outlook Web App. 

Method   

Expected results New contact successfully synced to the mobile device. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Microsoft Exchange Global Address List 

Test case number 5.2.7 

Resource name  

Date  

User scenario On the mobile device, perform a lookup for a user entry in the Microsoft Exchange 
Global Address List and send an email to the entry. 

Method   

Expected results Perform the user search successfully. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  

 
Office 365 installation 

Test case number 5.2.1 

Resource name   

Date  

User scenario  

Method   

Expected results  

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Previous Office Version Uninstall 

Test case number 5.2.2 

Resource name   
 

Date  

User scenario  

Method   

Expected results  

Pass/fail  

Observed results  

Environment  

Comments or information   
 

 
Activation and Deactivation for Multiple People on a Workstation 

Test case number 5.2.2 

Resource name  

Date  

User scenario  

Method   

Expected results   

Pass/fail  

Observed results  

Environment  

Comments or information  
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User Does Not Connect for Over 30 Days 

Test case number 5.2.2 

Resource name  

Date  

User scenario  

Method  

Expected results  

Pass/fail  

Observed results  

Environment  

Comments or information  

 
Password is one week from expiration 

Test case number 5.2.1 

Resource name  

Date  

User scenario Can notification be sent other than the pop up window in the task bar? 

Method   

Expected results  

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Password is one day from expiration  

Test case number 5.2.2 

Resource name  

Date  

User scenario Can notification be sent other than the pop up window in the task bar? 

Method   

Expected results  

Pass/fail  

Observed results  

Environment  

Comments or information  

 
IT Support resets Password with the FIM Password Reset Utility  

Test case number 5.2.2 

Resource name   

Date  

User scenario 

User contacts IT support for a password reset.  
IT support resets the password with FIM Password Reset Utility. 
Passwords have an 8 character minimum and are case sensitive.  
It must be 8 characters or longer and include at least one letter, one number and 
one special character (i.e. [!,@,#,$,%,^,&,*,(,)]); 
Not be one of your previously used passwords. 

Method   

Expected results 
Error message is displayed in the Reset Tool if requirements not met in password. 
User must be able to use the new password in the client in XX amount of time and 
in OWA in XX amount of time.  

Pass/fail  

Observed results  

Environment  

Comments or information  
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User resets Password with OAKS tool 

Test case number 5.2.2 

Resource name  

Date  

User scenario User uses the OAKS password reset tool.  

Method   

Expected results User must be able to use the new password in the client in XX amount of time and 
in OWA in XX amount of time.  

Pass/fail  

Observed results  

Environment  

Comments or information  

 
Sending a fax to a physical fax machine (ODOT, Commerce, and DPS) 

Test case number 5.2.1 

Resource name  

Date  

User scenario Enter a valid fax machine number in the To field with the following format: [fax:nnn-
nnn-nnnn]. Complete the email with subject and body text. 

Method   

Expected results Receiving fax device should get the fax. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information  
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Sending a fax to an ODOT Esker Fax Number (ODOT Only) 

Test case number 5.2.2 

Resource name  

Date  

User scenario Enter a valid ODOT Esker fax number in the To field with the following format: 
[fax:nnn-nnn-nnnn]. Complete the email with subject and body text. 

Method   

Expected results Fax delivered to the user’s mailbox. 

Pass/fail  

Observed results  

Environment Pre-production 

Comments or information List of ODOT valid fax numbers for testing: 614-887-4020, 614-887-4013 
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VELOCITY WEEK ACTIVITIES 
Once an Agency has completed all the prep work and has completed their Pilot sign-off we will 

move forward with the scheduled Velocity date. A few days prior to Velocity it is necessary to 

communicate the following information to the project team: 
• Velocity List 

• White Glove List 

• DO NOT Migrate List 

It is also important to make sure that a change-freeze is in place on all existing accounts. 

Please check your ticketing system to verify that changes have not been requested and/or that 

they have been completed prior to Velocity Day. 

Agency communication remains a vital piece of a successful migration. Please visit the Office 

365 SharePoint site http://office365.ohio.gov for valuable communication templates (T- 

communications) that will help you lead your Agency staff through this transition. 

On Velocity Day, members from DAS tech staff will be present at your Agency. All migration 

support issues should be routed through the Agency technical staff. DAS staff will be available 

for assistance when necessary. 

During the first week after migration, verify that the following checklist activities are being done: 

• Confirm and Test Shared Mailboxes 

• Confirm visibility of Distribution Lists 

• Confirm visibility of Archive Files 

• Remediate Mobile Devices 

• Confirm Legal Hold Mailboxes 

• Attend FIM Portal Refresher 

• Review On-Boarding/Off-Boarding Procedures 

•  

Also during Velocity week, DAS staff will be available for migration support issues and the 

project staff will schedule conference calls to provide communication of migration issues, report 

resolution and answer general migration questions.   

http://office365.ohio.gov/
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VELOCITY GO LIVE CHECKLIST 

VELOCITY GO LIVE CHECKLIST 

☐ All accounts on the [AgencyName] Velocity List have been migrated 

☐ [AgencyName] User Mailboxes have active licenses 

☐ [AgencyName] Users are able to log into OWA 

VELOCITY WEEK CHECKLIST 

☐ [AgencyName] User Client and Kiosk accounts have been signed into and are being 

used 

☐ Distribution Lists are visible in GAL and are operational 

☐ Shared Mailboxes are confirmed as connected and operational 

☐ [AgencyName] Users with Mobile Devices have activated devices 

☐ [AgencyName] Users’ Archives are visible 

☐ [AgencyName] technical support staff has received FIM Portal training and have the 

proper permissions 

☐ OIT and [AgencyName] have identified and remediated migration issues 

AGREEMENT 
We, AgencyName, agree that all Velocity Checklist Activities have been completed and Velocity 

is concluded. Any future incident handling will be in accordance with the SLA agreement and 

processed through the CSC. 

Agency Point of Contact Signature: ____________________________________ 

OIT Point of Contact Signature: _________________________ 
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